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Introduction 
This document describes the MAP-CAL Microsoft Windows™ based 
configuration application for the Performance Motor Research Limited Manifold 
Absolute Pressure Electronic Control Unit (MAP-ECU).  MAP-CAL is designed 
to run on Pentium class Industry Standard PC’s using Microsoft Windows 95™, 
Windows 98™, Windows NT™ or Windows 2000™ operating systems.  The 
MAP-CAL software provides an interface for programming and monitoring the 
MAP-ECU via a serial ‘COM’ port.  MAP-CAL is configured to use the following 
default serial port configuration: 

• 9600 baud 
• 8 bits 
• 1 stop bit 
• Even parity 

 
Any standard serial port (COM 1-4) can be utilized with the DB9 cable provided 
with the MAP-ECU. 

Features 
The MAP-CAL software has the following features: 

• Real-time monitoring of MAP-ECU inputs and outputs. 
• Real-time programming of MAP-ECU tables and parameters. 
• 2D and 3D data visualisation and manipulation. 
• Offline data manipulation. 
• Configurations can be saved and retrieved from disk. 
• Logging functions on all inputs and outputs, including the ability to save 

logs to disk. 
 

Installation 
MAP-CAL is supplied on CDROM and requires approximately 7MB of disk 
space.  The default installation directory is C:\Program Files\MAP-ECU.  Run the 
setup.exe program from the CDROM in order to complete installation.  The first 
screen should be as follows: 
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Ensure no other applications are running during installation in order to minimize 
the possibility of errors.  Select the OK button and the following screen will 
appear: 

 
 
If you wish to change the installation directory, select the ‘Change Directory’ 
button or select the icon to accept the default directory. 
 
The following screen will appear if you chose to change the directory: 

 
 
Use the ‘Directories’ and/or ‘Drives’ boxes to find an existing directory or alter the 
‘Path’ as required. 
 
If the new directory selected does not exist, Setup will ask if you wish to create a 
new directory, as follows: 
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Select ‘Yes’ to create the new directory or ‘No’ to return to the directory selection 
screen.  Once an install directory is selected, Setup will ask which program group 
the MAP-CAL should be located, the default being MAP-ECU as follows: 

 
 
Should you wish to create a program group with another name, simply type the 
name in the field below ‘Program Group’ or select an existing program group from 
the list.  Once you select ‘Continue’ the files will be copied to disk as per the 
following screen: 

 
 
Once the files are copied successfully, installation is complete and the following 
screen should appear: 

 
 
You are now ready to run MAP-CAL from the ‘Start’ menu. 
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Description 
Below is the interface presented when the MAP-CAL software is first started: 

 
 
Access to the various tabs are via shortcut function keys as described below. 
 
Note: The Status Box displays a message indicating a successful load of a Oxygen 
Sensor lookup table ‘O2.CFG’ located in the MAP-CAL directory.  If this file does 
not exist, or is corrupt, an error message will be displayed as follows: 

 
 
The following can be seen on this screen: 

• File Menu 
• Edit Menu 
• Help Menu 
• Dashboard Tab 
• 3D Graph Tab 
• Table Tab 
• Logs Tab 
• Logging Setup Tab 
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• Rev Counter (0-9000 rpm) 
• MAP Pressure Graph and reading 
• MAP Enrichment % 
• TPS % 
• TPS Enrichment % 
• ‘Online’ button 
• Output reading 
• ‘Mini’ Table 
• Table reading 
• Zone reading 
• An unlabelled field (AFM/VKF In) 
• AFM Input Voltage 
• Air/Fuel Ratio reading 
• Oxygen Sensor Voltage 
• Status box 
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File Menu (Alt+F) 
The following screen shot shows the options available under the File Menu at 
program startup, i.e. no data loaded and MAP-ECU offline: 

 
 
Options active from the File Menu include: 

• Open Data File 
• Open Log File 
• Exit 

 
Other options not active on the File Menu include: 

• Start Logging 
• Save Data File 
• Save Log File 
• Stop Logging 

 
These options are enabled and disabled depending on what state MAP-CAL and 
MAP-ECU are in, as described below. 

Open Data File (Ctrl+O) 
Open an existing data file with previously saved MAP-CAL data.  The data can be 
read, manipulated and saved Offline, or uploaded to a MAP-ECU connected to a 
serial port and then manipulated Online (real-time).  The filename extension for 
data files is ‘.tbl’ for ‘table’. 

 



 

 MAP_ECU_USA 10 of 48 27 August, 2004 

Open Log File (Ctrl+R) 
Open a previously saved log file as described later in this document.  The 
extension for a log file is ‘.log’.  A previously created log file is opened using the 
following screen: 

 
 

Exit (Ctrl+X) 
Exit the MAP-CAL software.  Data will not be saved unless the Save function is 
used before exiting. 

Start Logging (F1) 
This option is only available when a MAP-ECU is Online and active. 

Save Data File (Ctrl+S) 
Save the current MAP-CAL data to a file.  All the MAP-ECU configuration data is 
saved, along with MAP-CAL configuration details, such as Com Port, etc.  The 
filename extension for data files is ‘.tbl’ for ‘table’. 

 
 
Note that there is a comment text box that allows the user to provide additional 
details about the file being saved.  This information is retrieved and displayed in 
the Status box when the file is loaded.  The field has a maximum length of 255 
characters, although 20-30 are typically used. 
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Save Log File (Ctrl+L) 
Save the current logged information in a file for later review.  This option is 
enabled when some log data has been collected.  The following dialog box appears 
when saving a log file: 

 
 
Note: The filename extension is defaulted to ‘*.log’. 

Stop Logging (F2) 
This option is only available when logging is active.  Current logging will stop 
immediately and can be displayed via the various graphs discussed later in this 
manual. 
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Edit Menu (Alt+E) 
The following screen shot shows the options available under the Edit Menu: 

 
 
Options active from the Edit menu are as follows: 

• Serial Configuration 
• Adjust Table 
• Fill Table 
• Set Password 

 
As a MAP-ECU is not ‘Online’ and no data is loaded, the following option is not 
active on the Edit Menu: 

• ECU Configuration 
 

ECU Configuration (Ctrl+U) 
If a MAP-ECU is Online, or valid data is loaded, the following screen would be 
accessible in order to configure the MAP-ECU: 
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Note: The ‘AFM 0’ field is labelled ‘Baro’, or Barometric Pressure output voltage 
in VKF mode. 
 
Note: MAP-CAL configuration changes are only written to the MAP-ECU after 
the ‘OK’ button is pressed. 

TPS Idle 
TPS input voltage at idle, i.e. minimum.  Valid settings for TPS Idle are integers 
from 0 to 4095. 

TPS Max 
TPS input voltage at ‘wide open throttle’ (WOT), i.e. maximum.  Valid settings for 
TPS Max are integers from 0 to 4095. 
 
The following operators can be used to edit TPS Idle and TPS Max when each 
field is selected: 
 

Key Function 
‘s’ ‘Sample’ the current TPS input.  (Should only be used with the 

MAP-ECU fully connected and the ignition on, but the engine not 
running). 

Backspace Delete the current value ready to retype a value. 
0-9 Numbers to enter a new value up to 4095. 

Return Enter the current value. 
 
Note:  The MAP-ECU handles reverse voltage TPS input voltages automatically, 
i.e. TPS Idle Voltage > TPS Max Voltage.  The MAP-ECU will assume the TPS 
operates in a reverse mode. 

AFM 0/Baro Setting 
The setting labelled ‘AFM 0’ has two functions.  When the user has a MAP-ECU 
for Von Karmen Vortex Frequency (VKF) generation, this controls the voltage 
applied to the Barometric Pressure input to the factory ECU (if present).  This 
allows the user to have fine control of the fuel/air mixture over the entire range if 
required.  Without the Barometric Pressure input to the factory ECU connected, an 
engine ‘Check’ light may result. 
 
When the user has a MAP-ECU for Hotwire or Flap Air Flow Meter (AFM), this 
value controls the voltage sent to the stock ECU when the Air Flow Meter senses 
no airflow, i.e. engine not running.  This needs to be programmable as the zero 
setting is never exactly 0 Volts or 5 Volts and depends on the AFM.  Incorrectly 
setting this value may result in an engine ‘Check’ light. 
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The Baro setting can be pre-set by the MAP-ECU when in ‘Learn Mode’ and the 
AFM Input signal is connected to the Barometric Pressure sensor output of the 
stock VKF air flow meter.  This is automatic with an AFM MAP-ECU before 
engine start. 
 
The AFM 0/Baro output voltage is set with values from 0 to 4095, where 0=0 
Volts and 4095=5 Volts.  The user must first select the field using the left mouse 
button, and then the keys function as follows:  Note that the equivalent voltage is 
displayed next to the field for reference. 
 

Key Function 
‘s’ ‘Sample’ the current AFM input.  (Should only be used with the 

MAP-ECU fully connected and the ignition on, but the engine not 
running). 

Backspace Delete the current value ready to retype a value. 
0-9 Numbers to enter a new value up to 4095. 

Return Enter the current value. 
 

Enable Auto Learn 
This switch instructs the MAP-ECU to enable Auto Learn mode internally.  The 
MAP-ECU must be power cycled before it will enter or exit Auto Learn mode.  A 
full description of Auto Learn mode can be found in the MAP-ECU manual. 

Cylinders 
The data field labelled ‘Cylinders’ is the number of Cylinders configured for the 
connected MAP-ECU and is only used for RPM calculations.  Determining this 
value is discussed in the MAP-ECU manual.  The only keys active to edit this field 
are ‘+’ and ‘-‘.  Pressing the ‘+’ key with the field selected will increment the 
‘Cylinders’ field and pressing the ‘-‘ key with decrement the Cylinders field.  
Valid settings are 1 to 16 cylinders. 
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AFM/VKF Indicator 
The field showing a Red background ‘VKF’ indicates the MAP-ECU connected is 
the Von Karmen Vortex Frequency type.  If a Hotwire or Flap type Air Flow 
Meter MAP-ECU is connected, a green background AFM is displayed, as follows: 

   
 
AFM and VKF modes can be toggled by selecting the field and using the ‘+’ key 
to select VKF and ‘-’ to select AFM mode. 

Enable VKF Input 
This switch is the only function enabled/disabled without pressing the ‘OK’ button 
and enables the MAP-ECU VKF input.  When enabled, the VKF Input field on the 
main screen will display the input frequency in Hz.  This switch must be disabled 
when the stock VKF air flow meter is removed as it is only used during initial set-
up and tuning. 

Switched Output Selection 
The MAP-ECU is equipped with two independent Switched Outputs, each can be 
disabled or configured for one of four possible functions: 

1. RPM 
2. PSI 
3. O2 
4. NOS 

 
The Switched Outputs can be disabled by selecting the ‘OFF’ function.  Switched 
Outputs must be configured differently, i.e. two Switched Outputs cannot be 
configured for the same function. 
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RPM>0 (Airflow Signal) 
One of the Switched Outputs can be configured to mimic an airflow switch.  Some 
airflow meters incorporate a switch to enable the fuel pump when airflow is 
detected.  In this mode the output is on, i.e. at zero volts, when RPM>0 and 
inactive when RPM=0.  In the above VKF example, RPM>0 is allocated to 
Switched Output 1. 

Pressure Switch Setting 
The Pressure Switch field contains the pressure at which the Pressure Switch 
function of the MAP-ECU will turn on, if the function is allocated to a Switched 
Output.  In the example above the setting is 9 PSI.  This means the pressure switch 
output of the MAP-ECU will turn on at 9 PSI, regardless of RPM.  This setting 
and control line can be used to drive an intercooler water mist pump relay or any 
other facility required based on Manifold Pressure.  Note that this is a simple 
binary operation switch which may not be suitable for waste gate control.  This 
setting may be set from 0 to 30 PSI, in 0.1 PSI increments, i.e. 9.1 PSI is valid. 
 
The following operators can be used to edit Pressure Switch setting: 

Key Function 
Backspace Delete the current value ready to retype a value. 

0-9 Numbers to enter a new value up to 30.0. 
Return Enter the current value. 

O2 Heater Drive 
One of the Switched Outputs can be configured to drive an Oxygen Sensor Heater 
element.  If ‘O2’ is allocated to one of the Switched Outputs, that output can be 
used to drive the heater of a 4-wire O2 sensor if the stock ECU does not already do 
so.  This can be useful if the user wishes to install a heated O2 sensor to replace a 
non-heated sensor.  Heated O2 sensors tend to be more accurate and generate an 
output voltage more quickly from cold start.  When the O2 sensor output drops 
below the Threshold Voltage (default 0.4V), the heater output will turn on 
(switched to ground).  When the O2 sensor voltage rises again, the heater output 
will turn off.  There are delays built into the software so the heater is not cycled 
too quickly.  In the above AFM example, O2 Heater Drive is allocated to Switched 
Output 2. 

O2 Threshold Voltage 
O2 Threshold Voltage is used when one of the Switched Outputs is configured as 
O2 Heater Drive.  This is the threshold voltage when the O2 Sensor is deemed to 
be at operating temperature and generating a valid output voltage.  O2 Threshold 
Voltage can be set from 0.0 to 5.0 volts in 0.1 volt increments. 
 
The following operators can be used to edit O2 Threshold Voltage setting: 
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Key Function 
Backspace Delete the current value ready to retype a value. 

0-9 Numbers to enter a new value from 0.0 to 5.0. 
Return Enter the current value. 

NOS Solenoid Drive 
One of the Switched Outputs can be configured to drive a NOS activation 
solenoid.  Activation is based on Minimum RPM, Maximum RPM and Minimum 
TPS.  If NOS is the selected function for one of the Switched Outputs, that output 
will be enabled when RPM is greater than Minimum RPM, less than Maximum 
RPM and TPS is greater than Minimum TPS.  In the above VKF example, NOS is 
allocated to Switched Output 2. 

TPS Enrichment Table 
This table determines the level of enrichment applied by the MAP-ECU to the 
output when fast transitions of the throttle are detected, similar to an accelerator 
pump.  The faster the transition, the more enrichment is applied as a product of 
transition speed and TPS Percent.  Transition speed is computed in the MAP-ECU 
using the integral of TPS input voltage.  An integral value of 0-100 percent is 
generated by the MAP-ECU internally which is then multiplied by TPS Percent 
and the result used to enrich the MAP-ECU output.  This means slow transitions of 
the throttle position result in little or no enrichment.  Maximum enrichment can 
only be achieved by a throttle position change from Idle to WOT within 
approximately 200mS.  Note that negative TPS transitions have no effect, i.e. 
additional leaning of the output signal is not provided.  Valid settings for TPS 
Percent are integers from 0 to 100.  It is vital that TPS Idle and TPS Max are set 
correctly otherwise TPS enrichment will not operate correctly.  The TPS 
Enrichment table is configured as eight (8) Zones in 1000, RPM increments, e.g. 
1000, 2000, 3000, etc. 

MAP Enrichment Table 
This table determines the level of enrichment applied by the MAP-ECU to the 
output when fast transitions of Manifold Pressure are detected, similar to the TPS 
Enrichment Table.  This function is provided for vehicles where a TPS signal is 
not available.  The faster the transition, the more enrichment is applied as a 
product of transition speed and MAP Percent.  Transition speed is computed in the 
MAP-ECU using the integral of Manifold Pressure.  An integral value of 0-100 
percent is generated by the MAP-ECU internally which is then multiplied by MAP 
Percent and the result used to enrich the MAP-ECU output.  This means slow 
transitions of the Manifold Pressure result in little or no enrichment.  Maximum 
enrichment can only be achieved by a large change in Manifold Pressure, e.g. Idle 
to WOT within approximately 200mS.  Note that negative Manifold Pressure 
transitions have no effect, i.e. additional leaning of the output signal is not 
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provided.  Valid settings for MAP Percent are integers from 0 to 100.  The MAP 
Enrichment table is configured as eight (8) Zones in 1000, RPM increments, e.g. 
1000, 2000, 3000, etc. 
 
Note: If both enrichment strategies are active, only one enrichment is ever applied, 
i.e. whichever computed result is greater. 

Firmware Version 
Displays the version number of the attached MAP-ECU. 
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Serial Configuration (Ctrl+I) 
The following screen shot shows the options available under the Serial 
Configuration option: 

 
 
This screen allows the user to set the COM Port, Baud rate, Number of Data Bits, 
Parity and Stop Bits.  The serial parameters should not normally be altered, apart 
from the COM Port, which will be determined by the users PC configuration. 

Adjust Table Data (Ctrl+J) 
The following screen shot shows the options available under the Adjust Table Data 
Menu: 

 
 
The Adjust Table Data menu has three data fields: 

• Adjust Row (1 to 17) 
• Adjust Column (1 to 22) 
• Adjustment Percentage (-100 to 100) 

 
Four buttons: 

• Row 
• Column 
• All 
• Cancel 

 
One switch 

• Adjust Percent/Constant. 

Adjust Row 
The ‘Adjust Row’ data field allows the user to select which row will be adjusted 
by the value entered in ‘Adjustment Percentage’.  Valid row numbers are 1 to 17 
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corresponding with the maximum number of rows in the data table.  Row 1 is 
minimum pressure, e.g. –10 PSI in this example, and Row 17 is maximum 
pressure, e.g. +30 PSI in this example.  Valid ‘Adjustment Percentage’ is an 
integer from 
–100 to 100.  A value of zero has no affect.  For example, should the user enter the 
number ‘1’ into the ‘Adjust Row’ data field, the number ‘10’ into the ‘Adjustment 
Percentage’ data field and then presses the ‘Row’ button, all the zones in row 1 
(-10 PSI) will be adjusted +10%.  Conversely, if –10 is entered for the 
‘Adjustment Percentage’, all the zones in row 1 would be adjusted by –10%, i.e. 
reduced.  These changes are automatically transferred to the MAP-ECU if one is 
online.  Otherwise, they are stored in the MAP-CAL memory for storing to disk or 
later upload to the MAP-ECU. 

Adjust Column 
The ‘Adjust Column’ data field and ‘Column’ button work in exactly the same 
way as ‘Adjust Row’ field and ‘Row’ button apart from operating against a 
‘Column’ of data.  ‘Adjust Percentage’ is used in exactly the same way.  For 
example, if the user entered the number ‘22’ into the ‘Adjust Column’ data field, 
the number ‘10’ in the ‘Adjust Percentage’ field and presses the ‘Column’ button, 
all the zones in Column 22 will be increased by 10%.  Conversely, if the value in 
‘Adjustment Percentage’ is –10, all the zones in Column 22 will be reduced by 
10%.  These changes are automatically transferred to the MAP-ECU if one is 
online.  Otherwise, they are stored in the MAP-CAL memory for storing to disk or 
later transferred to the MAP-ECU. 

All 
The ‘All’ button only uses data entered in the ‘Adjustment Percentage’ data field.  
If ‘10’ is entered as the ‘Adjustment Percentage’ and ‘All’ is pressed, the entire 
table is adjusted 10% up in value.  Conversely, if ‘–10’ is entered into the 
‘Adjustment Percentage’ data field, the entire table will be reduced in value by 
10%.  This function is very useful for making sweeping adjustments to allow for 
the installation of smaller or larger injectors, etc.  These changes are automatically 
transferred to the MAP-ECU if one is online.  Otherwise, they are stored in the 
MAP-CAL memory for storing to disk or later upload to the MAP-ECU. 
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Adjust Percent/Constant 
This switch allows the user to adjust by a constant rather than a percentage.  The 
following screen is displayed when ‘Constant’ mode is selected: 

 
 
In this mode all adjustments are made according to the constant in the ‘Adjustment 
Constant’ field in the same way as percentages are processed. 

Cancel 
The ‘Cancel’ button exits this function without modifying any data. 

Fill Table (Ctrl+T) 
The following screen shot shows the options available under the ‘Fill Table’ 
Menu: 

 
 
‘Fill Table’ is similar in operation to the ‘Adjust Table Data’ function.  This 
feature is useful for pre-filling a table in a MAP-ECU if the user is experimenting 
or developing a totally new table.  Performing such functions with a real engine 
can be dangerous if the user is inexperienced, as it may lead to damage to the 
engine due to incorrect air volume data, and hence fuel, being fed to the stock 
ECU. 
 
There are three data fields for this function as follows: 

• Fill Row (1 to 19) 
• Fill Column (1 to 22) 
• Fill Data (0 to 4095) 

 
And four buttons similar to ‘Adjust Table’: 

• Fill Row 
• Fill Col 
• Fill All 
• Cancel 
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Fill Row 
The ‘Fill Row’ button fills a row specified in the ‘Fill Row’ data field with the data 
entered into the ‘Fill Data’ field.  For example, if the user enters the number ‘3’ 
into the ‘Fill Row’ data field, ‘100’ into the ‘Fill Data’ field and presses the ‘Fill 
Row’ button, all of the zones in Row 3 (-6 PSI) will be filled with 100.  These 
changes are automatically transferred to the MAP-ECU if one is online.  Otherwise 
they are stored in the MAP-CAL memory for storing to disk and/or later transfer to 
the MAP-ECU. 

Fill Column 
The ‘Fill Col’ button fills a Column specified in the ‘Fill Column’ data field with 
the data entered into the ‘Fill Data’ field.  For example, if the user enters the 
number ‘3’ into the ‘Fill Column’ data field, ‘100’ into the ‘Fill Data’ field and 
presses the ‘Fill Col’ button, all of the zones in Row 3 (-6 PSI) will be filled with 
100.  These changes are automatically transferred to the MAP-ECU if one is 
online.  Otherwise they are stored in the MAP-CAL memory for storing to disk 
and/or later transfer to the MAP-ECU. 

Fill All 
The ‘Fill All’ button only uses data entered in the ‘Fill Data’ field.  If ‘100’ is 
entered as the ‘Fill Data’ and ‘Fill All’ is pressed, the entire table is filled with the 
value ‘100’.  These changes are automatically transferred to the MAP-ECU if it is 
online.  Otherwise they are stored in the MAP-CAL memory for storing to disk or 
later transfer to the MAP-ECU. 

Set Password 
The MAP-ECU has a password protection facility that protects all data in the 
MAP-ECU.  With a password of ‘4095’ (the default), the MAP-ECU behaves as if 
it does not have a password.  Setting the password to anything other than 4095 will 
lock access to the MAP-ECU.  Valid passwords are in the range 0-4095. 
 
If the Set Password menu item is selected when the MAP-ECU is ‘Offline’, the 
following screen is presented: 
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The Password entered is used to authenticate against the MAP-ECU when the 
‘Online’ button is pressed.  If a password protected MAP-ECU is connected, this 
password must be set before pressing the ‘Online’ button. 
If the password is not set, or it is set incorrectly, the following screen will be 
displayed once the ‘Online’ button is pressed: 

 
 
Once a MAP-ECU is successfully ‘Online’ with the correct Password, the Set 
Password screen will alter slightly as follows: 

 
 
This version of the screen indicates the Current Password is ‘1234’ and allows the 
user to enter a New Password (0-4095).  When the ‘OK’ button is pressed, the new 
password is written to the MAP-ECU. 
 
Note: It is strongly recommended that a password is set only once MAP-ECU 
tuning is completed.  Once a MAP-ECU has been password protected, it is 
IMPOSSIBLE to break the password.  It must be returned to your local distributor 
for complete erasure. 
 

Help 
When the Help menu entry is selected, a message box displaying the software 
version number similar to the following is displayed: 
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MAP-ECU Data Loaded 

Dashboard Tab (F3) 
If the F3 key is pressed, the Dashboard Tab similar to this will appear: 

 
 
Note: The button labelled ‘Online’ changes it’s label depending on state.  Since the 
MAP-ECU is Offline, the button is labelled ‘Online’ indicating that pressing it will 
cause the MAP-CAL software to communicate with the MAP-ECU via the 
configured COM port, and therefore go ‘Online’.  When the MAP-ECU is Online, 
the button will change label to ‘Offline’, indicating that if the button is pressed the 
MAP-ECU will go Offline. 
 
Note: The Status box displays the comment field saved with data file, in this case: 
“7M-GTE 550cc Injectors”. 

Mini-Table 
A mini-table view is represented on the Dashboard to provide a visual reference, as 
follows: 

 
 
The red square indicates the current zone in the same way the zone is highlighted 
on the Table Mode tab (F5). 
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3D Graph Tab (F4) 
If the F4 key is pressed, the three-dimensional Graph Tab similar to this will 
appear: 

 
 
Note: This is the same data displayed in the two-dimensional table, but shown as a 
3D surface graph.  The Rows and Columns have the same values as the Table, i.e. 
RPM versus Pressure, but the data value is shown as the vertical scale.  Graph 
mode and its features are described in detail later in this manual. 
 
Note: The text box to the right of the Status box is for context sensitive help.  A 
summary of valid key strokes is displayed in the context sensitive help box 
depending on which function is currently active.  The above example is indicating 
which keys are active in Graph mode: “Press ‘PgUp’ or ‘PgDn’ for more or less 
fuel, ‘s’ or ‘S’ to sample the input.” 
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Invert ‘Y’ Axis Button (Alt+V) 
As this particular Flap Type AFM equipped vehicle uses an inverted voltage AFM 
(where minimum air flow equals maximum voltage and vice versa), the ‘Invert Y 
Axis’ button is available.  When this button is pressed, the graph becomes more 
readable, as follows: 
 

 
 
This display does not have grid lines showing. 

Grid Lines Button (Alt+I) 
It is possible to enable or disable grid lines in ‘Graph Mode’ using the ‘Grid Lines’ 
button.  ‘Grid Lines’ can cause the graph to be too complicated and therefore 
should be disabled unless graph values need to be viewed more accurately.  The 
graph changes as follows when Grid Lines are enabled: 
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Table Tab (F5) 
If the F5 key is pressed, a screen similar to this will appear: 
 

 
 
This mode allows the user to view the data in a simple two-dimension table 
allowing editing Offline or Online.  The details of how to manipulate data in Table 
mode are explained later in this manual. 
 

Logs (F6-F11) 
Unless log data is available, no logs will be displayed if F6, F7, F8, F9 or F11 are 
pressed.  These logs will be covered later in this manual under log modes. 

Logging Setup (Shift+F1) 
Logging setup allows configuration of the various logging parameters. 
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Online/Offline Button (Alt+N) 
Online mode is entered by pressing the button labelled ‘Online’.  The ‘Online’ 
button can be pressed before data is loaded from a data file, or after.  If the 
‘Online’ button is pressed before a file is opened, a simple ‘Yes’ or ‘Cancel’ 
option is presented before the MAP-ECU data is loaded.  If the ‘Online’ button is 
pressed after data is loaded from a file, a prompt will appear asking the user for a 
decision.  A screen similar to this will appear if a data file has already been 
opened: 
 

 
 
If the user selects ‘Yes’, MAP-CAL will upload the MAP-ECU with the current 
data in the MAP-CAL software, i.e. the contents of the data file.  Warning: This 
will overwrite any data in the MAP-ECU and it will not be recoverable.  If the user 
selects ‘No’, MAP-CAL will discard the data currently loaded and download all 
data from the MAP-ECU.  Again, the data in the MAP-CAL software will be 
deleted and cannot be recovered, unless a copy was saved to disk prior to pressing 
the ‘Online’ button.  Pressing the ‘Cancel’ button will terminate this prompt and 
no action will take place as if the ‘Online’ button was never pressed. 
 
If the user selects the ‘No’ option, MAP-CAL will attempt to communicate with a 
MAP-ECU connected to the COM Port configured.  Should MAP-CAL be 
successful communicating with a MAP-ECU, a screen similar to this will appear: 
 

 
 
The Status line is showing that MAP-CAL is reading the data tables from the 
MAP-ECU but the MAP-ECU is not yet fully online, i.e. Real-time mode.  Note 
also that another button has now appeared, labelled ‘FollowMe’.  ‘FollowMe’ is 
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part of the real-time edit mode which will be explained later in this manual.  
‘FollowMe’ is only available when the MAP-ECU is online, therefore it was not 
active before the button was pressed. 
 
If the user selects the ‘Yes’ option to the previous question, a screen similar to this 
would appear: 
 

 
 
Note: The Status box indicates that MAP-CAL is writing (downloading) the 
current data to the MAP-ECU before going into real-time Online mode. 
 
Once data transfer has concluded, approx. 15 seconds, a screen similar to this will 
appear: 
 

 
 
The MAP-ECU is fully online, showing current readings from the MAP-ECU, 
such as current Pressure, RPM and calculated Output.  Note that another new 
button has appeared, labelled ‘Reload’.  This allows the user to request a data 
transfer from the MAP-ECU, overwriting all data in MAP-CAL. 
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Online Graph 
If the F4 key is pressed, or the ‘3D Graph’ Tab selected, when the MAP-ECU is 
Online, a screen similar to the following will appear: 
 

 
 
In ‘Online’ mode, the centre of the red square indicates the active zone with small 
red lines on the Pressure and RPM axes indicating their actual positions.  Note that 
the ‘Invert Y Axis’ button has been pressed to invert the table in this example. 

Online Table 
If the F5 key is pressed, or the ‘Table’ Tab is selected, when the MAP-ECU is 
Online, a screen similar to the following will appear: 
 

 
 
 
The ‘Zone’ highlighted with a dotted box indicates the currently active Zone.  Note 
that ‘FollowMe’ is deactivated therefore the active zone does not necessarily 
match current pressure and RPM.   As with the previous Graph Mode example, 
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context sensitive help is provided below the Table with a summary of key strokes 
available for the selected function. 

Zone Reading 
The value in the ‘Zone’ field always shows the current zone being accessed 
whether’ Online’ or ‘Offline’.  This ‘Zone’ number reflects each of the zones in 
the MAP-ECU data table.  The first one or two digits refer to the row number, i.e. 
1-17 and the last two digits, the column number.  A more in depth discussion on 
zone numbering can be found in the MAP-ECU manual.  In this example, the 
current zone is 1114, which corresponds with +15 PSI and 1600 RPM. 

Table Reading 
The ‘Table’ field is the current value in the data table at the zone currently shown.  
Therefore, in the example above, the table has the value 406 at zone 1114. 

Output Reading 
The ‘Output’ field (1022) is the current computed output from the MAP-ECU 
based on zones surrounding actual RPM and pressure.  A discussion of how this 
value is computed can be found in the MAP-ECU manual.  It should be noted that 
this value is only valid when the ECU is Online, as it is read from the MAP-ECU, 
not computed by MAP-CAL. 

Pressure (PSI) Field 
There are two pressure indicators.  One is the digital field under the ‘Pressure 
(PSI)’ label that displays current manifold pressure, in Pounds Per Square Inch 
(PSI), from +30 (Boost) to –10 (Vacuum) in this example.  Above the label, is an 
analogue gauge using a black line to indicate the pressure reading.  This value is 
read from the MAP-ECU in Online mode and is real-time. 

Status Field 
The Status field is used by MAP-CAL to inform the user of events in progress, or 
error messages.  Error messages are usually related to errors communicating with 
the MAP-ECU due to incorrect COM Port configuration or poor cabling.  Note 
that the normal status message during real-time ‘Online’ mode is ‘Reading Data’ 
which indicates that MAP-CAL is reading information from the MAP-ECU.  
Status messages will appear when MAP-CAL attempts to write configuration, zone 
or line changes during editing, e.g. Writing Zone 612. 

AFM In Field 
The field labelled ‘AFM In’ reports the current Hotwire or Flap AFM input 
voltage where 0=0 Volts and 4095=5 Volts as used by the MAP-ECU table.  This 
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field is renamed ‘VKF In’ or Von Karmen Vortex Frequency input when a VKF 
AFM ECU is in use. 

Air/Fuel Ratio Display 
The box labelled A/F Ratio displays the current Air/Fuel ratio based on O2 sensor 
voltage and the table read from the O2.CFG file.  Note: This Air/Fuel ratio must 
not be used for accurate tuning purposes.  A professional Air/Fuel ratio meter 
should be used for actual tuning. 

Graph Mode (F4) 
Graph mode can only be accessed once MAP-CAL has data loaded.  This can be 
achieved by connecting the PC to a MAP-ECU and pressing the ‘Online’ button, 
which will enable the MAP-CAL software to upload data from the MAP-ECU as 
already discussed.  Alternatively, if the user opens a valid data file, both Graph and 
Table modes will be enabled.  When data is loaded and the Graph button is 
pressed, a screen similar to this will appear: 

 
 
The Zone and Table fields now dynamically show data from the Graph.  The Zone 
field (608) is the Zone where the centre of the red-cross is active and the Table 
field shows the data value at that Zone (109). 
In this mode, the Adjust Percentage data field also becomes active.  Note that in 
this case, the ‘Invert Y Axis’ button has been pressed. 

Adjust Percentage 
Adjust Percentage is a data field the user can leave blank, or enter an integer 
between 1 and 100.  This value is used when modifying data in graph mode.  
Adjust Percentage is used when ‘PgUp’ or ‘PgDn‘ keys are pressed.  Instead of 
incrementing or decrementing the value by 1, the value is modified by ‘Adjust 
Percentage’ of the current value. 
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Graph Edit Mode 
In Graph Edit Mode, the following keys are active: 
 

Key Function 
PgUp Increment the data value at the centre of the red current zone field.  If 

Adjust Percentage is blank or zero, the data at that zone is incremented 
by one.  If there is a valid number in Adjust Percentage (1-100) then 
the data in that zone is increased by that percentage, e.g. if the data 
value is 100, and Adjust Percentage is set to 10, after pressing ‘PgUp’ 
once, the new value will be 110. 

PgDn Decrement the data value at the centre of the red current zone field.  If 
Adjust Percentage is blank or zero, the data at that zone is decremented 
by one.  If there is a valid number in Adjust Percentage (1-100) then 
the data in that zone is decreased by that percentage, e.g. if the data 
value is 100, and Adjust Percentage is set to 10, after pressing ‘PgDn’ 
once, the new value will be 90. 

↑ Cursor ‘up’.  Moves the red cursor edit box up the graph, i.e. towards 
the +30 PSI Row, or Row 17. 

↓ Cursor ‘down’.  Moves the red cursor edit box down, i.e. towards the 
–10 PSI Row, or Row 1. 

← Cursor ‘left’.  Moves the red cursor edit box left, i.e. towards the 200 
RPM Column, or Column 1. 

→ Cursor ‘right’.  Moves the red cursor edit box right, i.e. towards the 
8000 RPM Column, or Column 22. 

‘s’ ‘Sample’ the current input AFM or VKF input and insert it into the 
current Zone.  This is useful when setting up a new table in parallel 
with the stock air flow meter. 

 
Note:  The ‘Cursor’ keys listed above only function when the MAP-ECU is 
offline, or ‘FollowMe’ mode is disabled.  The ‘PgUp’, ‘PgDn‘ and ‘s’ keys work 
in all modes as described. 
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Table Mode (F5) 
Table mode can only be accessed once the MAP-CAL has data loaded.  This can 
be achieved by connecting the PC to a MAP-ECU and pressing the ‘Online’ 
button, which will enable MAP-CAL to load data from the MAP-ECU as already 
discussed.  Alternatively, if the user opens a valid data file, both Graph and Table 
modes will be enabled.  When data is loaded and the Table button is pressed, a 
screen similar to this will appear: 
 

 
 
Note: Parameters such as Adjustment Percentage are carried over between Table 
and Graph modes. 
 
The currently active Zone is highlighted by the dotted line box, in this case Zone 
1114, which contains the data value 406. 
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Show Logs 
The Show Logs button will highlight any logged information on the table in the 
same colour as the log graphs, e.g. Red for the first log, Green for the second, etc., 
as follows: 

 
 
This example is a simple log showing a change in RPM from 800 to 8000 as per 
the following log: 

 
 

Erase Logs 
The Erase Logs button will remove any log information highlighted on the table, 
i.e. revert to normal display. 
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Table Edit Mode 
In table Edit Mode, the following keys are active: 

Key Function 
Backspace Erase the data in the current field. 

Escape Restore the previous value if the user has started typing a new 
value, i.e. undo. 

↑ Cursor ‘up’.  Moves the edit box up the table, i.e. towards the –10 
PSI Row, or Row 1. 

↓ Cursor ‘down’.  Moves the edit box down, i.e. towards the +30 PSI 
Row, or Row 17. 

← Cursor ‘left’.  Moves the edit box left, i.e. towards the 200 RPM 
Column, or Column 1. 

→ Cursor ‘right’.  Moves the edit box right, i.e. towards the 8000 
RPM Column, or Column 22. 

‘0-9’ Valid digits in order to enter data from 0 to 4095. 
‘Return’ Enter data typed into the table, and if the MAP-ECU is online, send 

the changes to the MAP-ECU. 
Mouse The user can select any data field in the table using the mouse 

pointer and the left mouse button. 
‘s’ ‘Sample’ the current input AFM or VKF input and insert it into the 

current Zone.  This is useful when setting up a new table in parallel 
with the stock air flow meter. 

‘+’ or ‘=’ Increment the data value at the centre of the red current zone field.  
If Adjust Percentage is blank or zero, the data at that zone is 
incremented by one.  If there is a valid number in Adjust 
Percentage (1-100) then the data in that zone is increased by that 
percentage, e.g. if the data value is 100, and Adjust Percentage is 
set to 10, after pressing ‘+’ once, the new value will be 110. 

‘-‘ Decrement the data value at the centre of the red current zone field.  
If Adjust Percentage is blank or zero, the data at that zone is 
decremented by one.  If there is a valid number in Adjust 
Percentage (1-100) then the data in that zone is decreased by that 
percentage, e.g. if the data value is 100, and Adjust Percentage is 
set to 10, after pressing ‘-’ once, the new value will be 90. 

 
Note:  The ‘Cursor’ keys listed above only function when the MAP-ECU is 
offline, or ‘FollowMe’ mode is disabled.  The ‘+’, ‘-‘ and ‘s’ keys work in all 
modes as described.  Also, if a field is modified and the cursor is moved, the 
change will be written to the MAP-ECU automatically.  A message will appear in 
the Status Field indicating the write to a zone has occurred. 
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FollowMe Mode (Alt+W) 
FollowMe disabled is the default setting when a MAP-ECU is online.  FollowMe 
is not available when a MAP-ECU is offline.  FollowMe only works in Graph and 
Table edit modes and simply forces MAP-CAL to track which Zone is being 
accessed, dynamically, based on real-time information from the MAP-ECU.  This 
allows the user to track and edit the active Zone being used by the MAP-ECU in 
real-time. 
 
The FollowMe button works in a similar way to the Online/Offline button in that 
the label changes to reflect what action will take place when it is pressed.  When 
the button is labelled ‘FollowOff’, pressing the button will turn off FollowMe 
mode as the button suggests.  When the button is labelled ‘FollowMe’, pressing 
the button will enable FollowMe. 
 
When Table Mode is accessed in FollowMe mode, the active zone is highlighted in 
red, as follows: 

 
 
Note: In order to move the cursor in Table or Graph modes, ‘FollowMe’ must be 
disabled. 
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Logging 
A log display mode is provided in conjunction with the ability to save logs to disk.  
When a MAP-ECU is Online, the user can start and stop logging using the F1 and 
F2 keys respectively.  An automatic mode is provided where logging can be started 
and stopped based on RPM.  Logging records the following information: 

• RPM 
• Output (F6) 
• Pressure Input (F7) 
• TPS Input (F8) 
• O2 Sensor Voltage (F9) 
• AFM/VKF Input (F11) 

 
Up to six (6) independent logs can be recorded and displayed simultaneously.  
Each log is displayed in a different colour (red, green, blue, yellow, pink and light 
blue as follows: 
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Logging Setup (Shift+F1) 
Logging is configured through the Logging Setup Tab or by pressing Shift+F1 
keys, as follows: 

 
 
The fields available include: 

• Start RPM 
• Stop RPM 
• Automatic Logging select 
• Display O2 and Voltage select 
• Log Entries per second 
• Enable O2 Input select 
• Enable AFM/VKF Input select 
• Use ‘AFM In’ for O2 
• Erase Logs button 

 
The table displayed shows the current ‘O2.CFG’ lookup table loaded.  This table is 
non-modifiable as all changes are required in the data file. 

Start RPM 
This value sets the RPM at which logging will automatically start.  Valid entries 
are 1-8000.  Note: Start RPM must be less than Stop RPM otherwise an error will 
be reported. 

Stop RPM 
This value sets the RPM at which logging will automatically stop.  Valid entries 
are 1-8000.  Note: Stop RPM must be greater than Start RPM otherwise an error 
will be reported. 
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Automatic Logging 
When correct values are entered in the Start and Stop RPM fields, selecting this 
switch enables the auto log function.  The MAP-CAL software will automatically 
jump to Dashboard mode while waiting for the Start RPM.  MAP-CAL will ‘Beep’ 
when logging starts and stops.  The Status field also indicates logging is in 
progress, as follows: 
 

 
 

Display O2 as Voltage 
Changes the Air/Fuel Ratio log display to voltage mode.  The log scale changes to 
voltage as follows: 
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Disabling the switch allows Air/Fuel Ratio display as follows: 

 
 

Log Entries per Second 
This pull down box allows the user to change the logging rate from the default 10 
per second to 1-10 per second. 
 

Enable O2 Input 
Enables or disables the O2 sensor input for display and logging.  The default is 
enabled.  When the O2 sensor input is disabled, the displays are removed from the 
Dashboard as follows: 

 
 



 

 MAP_ECU_USA 42 of 48 27 August, 2004 

Enable AFM/VKF Input 
Enables or disables the AFM/VKF Input for display and logging.  The default is 
enabled.  When the AFM/VKF Input is disabled, the displays are removed from 
the Dashboard as follows: 

 

Use ‘AFM In’ for O2 
The O2 sensor input has a range of 0-4V.  Should a range of 0-5V be required for 
the O2 Sensor, it is possible to use the AFM Input for the O2 Sensor by enabling 
this option. 

Erase Logs 
Erases all data currently logged. 

Output (F6) 
RPM and Output voltage or frequency is displayed as follows: 
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The scale will alter depending on the mode, i.e. AFM or VKF, as follows: 

 
 

Pressure (F7) 
RPM and Pressure input in PSI is displayed as follows: 

 
 
Note: Pressure on this example does not vary over this sample period. 
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TPS (F8) 
RPM and throttle position (TPS) as a percentage of travel, as follows: 

 
 
Note: TPS on this example does not vary over this sample period and is at idle. 
 

Air/Fuel Ratio (F9) 
Air/Fuel ratio or O2 sensor voltage as follows: 
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AFM/VKF Input (F11) 
Hotwire or Flap  AFM Input voltage or Von Karmen Vortex Frequency VKF Input 
frequency as follows: 

 
 
 

Log Investigation 
All log data can be investigated by selecting the graph and any data point on that 
graph.  When a graph line is first selected, all data points will be selected, as 
follows: 
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When an individual data point is selected, the data associated will be displayed in 
the respective fields at the bottom of the screen, as follows: 

 
 
Note: In addition, the Series field is set to the respective line number (1-6).  If a 
blue line was selected, the Series field would be 2.  Zoom Start is also set to the 
data point number selected, in this case 10. 
 
Note: RPM or any data graph can be selected for investigation. 

Log Zoom 
A Log Zoom mode is available to examine sections of data.  In order to activate 
Log Zoom mode, Series, Zoom Start and Zoom End values are required.  Zoom 
Start and Series are automatically entered when a data point is selected.  A Zoom 
End value can be entered by selecting a data point while holding the ‘Shift’ key on 
the keyboard, as follows: 
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Once all three fields have valid data, the Zoom button can be pressed to zoom in 
on the section selected, as follows: 

 
 
Note: Zoom is only available once.  To return the graph to full display, press the 
appropriate function key again, e.g. F6. 
 

Saving a Log 
By default, enabling Log mode does not record data to disk, this is an independent 
operation enabled through the File menu as described previously. 
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Appendix 1 - Shortcut Keys 
The follow list of shortcut keys are available for the various menu items. 
 

Shortcut Function 
Alt+E Edit Menu 
Alt+F File Menu 
Ctrl+I Serial Configuration 
Ctrl+J Adjust Table 
Ctrl+T Fill Table 
Ctrl+O Open Data File 
Ctrl+S Save Data File 
Ctrl+R Open Log File 
Ctrl+L Save Log File 
Ctrl+U ECU Configuration 
Ctrl+X Exit 
F1 Start Logging 
F2 Stop Logging 
F3 Dashboard 
F4 3D Graph Mode 
F5 Table Mode 
F6 Output Log 
F7 Pressure Log 
F8 TPS Log 
F9 Air/Fuel Log 
F11 AFM/VKF Log 
Shift+F1 Logging Setup 
 
 
The follow list of shortcut keys are available for the various buttons. 
 

Shortcut Function 
Alt+I Grid Lines Button 
Alt+J Adjust Constant Button 
Alt+N Online/Offline Button 
Alt+R Reload Button 
Alt+V Invert ‘Y’ Axis Button 
Alt+W FollowMe/FollowOff Button 
 
 


